Copyright

The 2014 Drake Software Manual Supplement: Charities and Non-Profits, Drake Tax Software, and any other related materials are copyrighted material. All rights are reserved by Drake Enterprises, LTD, including all ownership rights. This document, associated software, and related material are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and reproduce the material in this document in an unaltered form only for your personal, non-commercial use or for non-commercial use within your organization. Copyright, trademark, and other proprietary notices may not be removed.

© 2014 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, there is no warranty, expressed or implied, to that effect. Drake Enterprises, LTD, assumes no liability for damages or claims resulting from the use of the information contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake Enterprises, LTD.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries.

Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies.
# Table of Contents

What’s New in Drake for Charities and Non-Profits .............................................. 1
  Form 3115 ............................................................................................................. 1
  Schedule A ........................................................................................................... 1
  Schedule H ........................................................................................................... 2
  Missing IDs ......................................................................................................... 2
  Unlimited Forms 2848 ........................................................................................... 2
  New ACA Fields on Form 8941 ............................................................................ 2
  Safe Harbor Elections ............................................................................................ 3
  Practice Management Tools .................................................................................. 3

Getting Started ..................................................................................................... 3
  Creating a Return ................................................................................................. 3
  Updating a Prior-Year Return ............................................................................ 4

Schedule O ............................................................................................................. 4
  Form 990-N .......................................................................................................... 5
  Form 990-EZ ........................................................................................................ 6
  Form 990-EZ Screens ........................................................................................... 6
  Form 990-PF ........................................................................................................ 6
  Form 990-PF Screens ........................................................................................... 7
  Recommended Order for Completing Form 990-PF ........................................... 7

Form 990-T ............................................................................................................. 9
  Form 990-T Screens ............................................................................................... 9
  Recommended Order for Completing Form 990 .................................................... 10
  Header Information (Forms 990, 990-EZ, 990-PF, 990-T, 990-N) ...................... 11
  Schedule R ........................................................................................................... 12
  Part VII, Section A ............................................................................................... 13
  Parts VIII, IX, and X ......................................................................................... 13
  Header Line G ...................................................................................................... 14
  Parts III, V, VII, and XI .................................................................................... 14
  Schedule L, Transactions With Interested Persons .............................................. 16
  Part VI, Governance, Management, and Disclosure ......................................... 16
  Part I, Summary ................................................................................................... 17
  Part IV, Checklist of Required Schedules ........................................................... 17
  Schedules ............................................................................................................. 21

Filing an Extension .................................................................................................. 22

Amending a Return .................................................................................................. 23

Form 3115, Application for Change in Accounting Method .................................. 23
  Accessing Screens for Changing Accounting Method ........................................ 24
Form 3115 Screens ................................................................. 25
Safe Harbor Elections .......................................................... 32

**Binary Attachments** ............................................................... 33
The PDF Attachment Process .................................................. 33
Printing Generated Documents .............................................. 36

**Using the PRNT Screen** .......................................................... 36
Suppressing/Forcing Items ..................................................... 36
Overriding Other Setup Options ........................................... 37
Turn Off Autobalance ............................................................ 37

**Electronic Filing** ................................................................. 37
IRS Error Reject Codes ........................................................ 38

**Index** .................................................................................. v
Charities and Non-Profits (990)

Data entry on a tax-exempt organization (990) return is the same as data entry on the 1040. Help, shortcut keys, and navigation through data entry all function as they do in the 1040. See Drake Software User’s Manual: Tax Year 2014 for the basics of using the program.

What’s New in Drake for Charities and Non-Profits

Drake programs its tax software according to the latest IRS rules and regulations. The 2014 program reflects all IRS changes to credits and deductions, including discontinuations. For specific details to the IRS’s changes, see the IRS instructions for individual forms for tax-exempt organizations.

For a complete list of all the changes the IRS has made to Forms 990, see the “What’s New” section of the IRS instructions.

The following section explains the main change to the 990 package for 2014.

Form 3115

Form 3115, Application for Change in Accounting Method, is now available in the 990 package and eligible for e-file. See “Form 3115, Application for Change in Accounting Method” on page 23 for details of using Drake to file this form.

Schedule A

The biggest change to the 990 this year is to Schedule A. The IRS added Parts IV and V (Drake included screens A4 and A5 to accommodate these additions), and modified Part I, line 11. (In Drake, see screen A, Public Charity Status, for the changes to Part I, line 11).

The IRS has also clarified the instructions for Schedule A, Part II, allowing an organization to complete Part II even if it selects a public charity box in Part I other than for section 170(b)(1)(A)(vi). See the IRS instructions for more information.
See “Schedule A” on page 18 for information on completing Schedule A in Drake.

**Schedule H**

Schedule H has also been changed by the IRS, in particular Part V, Section B, which requires reporting on hospital facilities. The organization must complete a Section B for each of its hospital facilities or facility reporting groups listed in Schedule H, Part V, Section A.

In Drake, Part V, Section B is completed on screen **H5** (accessed from the Schedule H-R tab of the Data Entry Menu). Note that Part V, Section B, is divided into three screens: **Part V-1**, **Part V-2**, and **Part V-3**, accessed through the tabs at the top of screen **H5**.

**Missing IDs**

In the past, if the organization had dealings with individuals or organizations outside the United States—for instance, if the organization held bank accounts in foreign countries—and these organizations or individuals did not an ID number, then you typed **FOREIGNUS** into the identification number field on a Drake screen. If the foreign person or organization had applied for an SSN or EIN but had not yet received an ID number, then you would have typed **APPLD FOR** in the **ID** field.

Now, to help avoid a data-entry error that might lead to an IRS reject, Drake will auto-fill many of the identification number fields in the program. For instance, on screen **3115**, type **F** into the **ID Number** field and **FOREIGNUS** is automatically entered (see Figure 1), or type **A** and **APPLD FOR** appears.

![Figure 1: FOREIGNUS is autofilled in the ID Number field of certain screens](image)

**Unlimited Forms 2848**

You can now enter an unlimited number of representatives on the redesigned **2848** screen when filling out Form 2848, Power of Attorney. When you need another **2848** screen to enter information on another representative, press **PAGE DOWN**.

**New ACA Fields on Form 8941**

Fields were added to the **8941** screen to allow you to complete the two new lines at the top of Form 8941, Credit for Small Employer Health Insurance Premiums. These new
lines, added by the IRS, determine if the organization provided health care coverage
for its employees as mandated by the Affordable Care Act, and determines if the orga-
nization is eligible to use Form 8941.

Safe Harbor Elections

A check box was added to screen 4562 to apply a small taxpayer Safe Harbor election
to a building listed in the Description field. An election statement will be produced
and the building description as entered in the Description field will be included in the
election statement.

Two other elections are now available from the Elections drop list on the ELEC
screen:

• Sec. 1.263(a) - 1(f) de minimis safe harbor election
• Sec. 1.263(a) - 3(n) Election

Election statements are generated with the return.

The Sec. 1.263(a) - 3(h) election can be made from either the ELEC screen or the
4562 screen. See “Safe Harbor Elections” on page 32 for more.

Practice Management Tools

For details on additions and enhancements to Drake’s practice management tools—
such as the e-mail program, the letters and billing editor, and the Scheduler—see the

Getting Started

Some early tasks you may need to perform when getting started on a 990 return
include creating a return (for new clients) or updating a return (for existing clients).

NOTE

Use blank forms to help clients collect tax-related data you will need. To
access blank forms, go to Tools > Blank Forms and select the Tax-
Exempt tab. Select a form from the list and click Print.

Creating a Return

To create a new return in Drake:

1. From the Home window, click Open/Create (or select File > Open/Create
   Returns, or press CTRL+O).
2. In the Open/Create a New Return dialog box, enter the organization’s nine-digit
   identification number.
3. Click OK. Click Yes when asked if you want to create a new return.
4. In the New Return dialog box, select Tax Exempt - 990 and enter the organiza-
   tion’s name.
5. Click OK.
Screen 1 of the return is displayed. You can now begin entering header information for the organization.

**NOTE**
Header information for all forms is completed on screen 1. For information on specific fields in screen 1, see “Header Information (Forms 990, 990-EZ, 990-PF, 990-T, 990-N)” on page 11.

**Updating a Prior-Year Return**
If you prepared the organization’s tax return last year, you must update it for 2014.

Prior-year returns can be updated in three ways:

- A single return (updated one at a time) using Last Year Data > Update Clients 2013 to 2014 (recommended)
- When you open an existing return from a prior year for the first time in the 2014 program and are prompted to update it
- With all other returns in the program using Last Year Data > Update Clients 2013 to 2014 (not recommended)

Drake recommends using the first option (updating returns individually) to ensure that you update only those items in a return that you want updated.

**NOTE**
If you attempt to open a prior-year 990 return that was marked as “final” the previous year, the program informs you that the return was marked as final before it prompts you to proceed.

**Schedule O**
Use screen O to provide narrative information for Schedule O and for other schedules. Where in the return such information flows depends in part on which 990 type you’re working on, and in part on which item you select from the Schedule drop list on the O screen (see Figure 2 on page 5).

In general, the leading letter of the selection from the Schedule drop list indicates where the information will go. For instance, a selection of A1 through A9 generally sends the information to Schedule A, and selections of C1 through C7 generally sends the information to Schedule C, and so forth.

Select Z1 through Z11, however, and the information flows to Schedule O of the 990-EZ. Select X for general statements and the information flows to the Schedule O and the attachment will be e-filed with an e-fileable return (990, 990-EZ, or 990-PF). A selection of AMD (for an amended return) also sends the information to Schedule O of either a 990 or 990-EZ return.

Drake Software User’s Manual Supplement: Charities

Form 990-N

Form 990-N, Electronic Notice (e-Postcard) for Tax-Exempt Organizations Not Required to File Form 990 or 990-EZ, is required for certain small tax-exempt organizations.

To file the e-Postcard using Drake, go to screen 1 for the organization and take the following steps:

1. Under the **General Information** heading, select **N - Form 990-N** from the **Form** drop list (item #1 in Figure 3).

2. At the bottom of the **General Information** section, mark the **990-N Only** check box to indicate that the organization’s gross receipts are normally not more than $50,000 (item #2 in Figure 3).

3. Go to the OFF screen and complete the **Name** and **Title** fields, enter an address (or select the **Use entity address** check box), and for at least one officer, select **Principal officer**.

**NOTE**

The SCH2 screen in a 990-PF return is the same as the O screen in the 990 and 990-EZ returns.

Figure 2: A selection beginning with Z will flow to the Schedule O of the 990-EZ

Figure 3: Begin by selecting **N - Form 990-N** from the **Form** drop list on screen 1.
Once any EF messages have been eliminated, the 990-N information can be e-filed. A “Form 990-N Information” page (“990_N” in View mode) will be generated with the return for informational and bookkeeping purposes.

NOTE

For information on signing a return prior to e-filing, see “Part II, Signature Block” on page 21.

Form 990-EZ

Certain organizations can file Form 990-EZ, Short Form Return of Organization Exempt From Income Tax, instead of Form 990. If an organization’s gross receipts (total amounts received from all sources during its annual accounting period) are less than $200,000 and total assets at year-end are less than $500,000, it can file Form 990-EZ instead.

Form 990-EZ Screens

The following screens are specifically provided for completing Form 990-EZ. They are grouped under the 990-EZ only heading of the Form 990/990EZ tab.

Table 1: 990-EZ Screens Under Form 990/990EZ Tab

<table>
<thead>
<tr>
<th>Screen</th>
<th>Title/Section on Form 990-EZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>Part I, Revenue and Expenses</td>
</tr>
<tr>
<td>22</td>
<td>Parts II and III, Balance Sheet/Accomplishments</td>
</tr>
<tr>
<td>23</td>
<td>Part V, Other Information, Page 1</td>
</tr>
<tr>
<td>24</td>
<td>Part VI, Section 501(c)(3) Only</td>
</tr>
<tr>
<td>O</td>
<td>Schedule O, Supplemental Information</td>
</tr>
<tr>
<td>SCH3</td>
<td>Other Items</td>
</tr>
<tr>
<td>SCH5</td>
<td>Part I, Line 5c</td>
</tr>
<tr>
<td>SC21</td>
<td>Unreported Activities</td>
</tr>
<tr>
<td>SC40</td>
<td>Part I, Grants and Similar Amounts Paid</td>
</tr>
<tr>
<td>SC42</td>
<td>Part II, Other Assets/Liabilities</td>
</tr>
</tbody>
</table>

Form 990-PF

Form 990-PF must be filed by certain exempt private foundations; see the IRS Form 990-PF instructions for specific information on who must file this form.

NOTE

For information on signing a return prior to e-filing, see “Part II, Signature Block” on page 21.
Form 990-PF Screens

The 990-PF–specific screens are located under the Form 990PF tab (Figure 4).

![Figure 4: Form 990PF tab in Drake (partial menu)](image)

Several screens, such as screen 1, the DEPR, IND, and OFF screens, and certain schedule (SCH or SC) screens, can also be found elsewhere in the menu, as they apply for multiple forms and not just the 990-PF.

Recommended Order for Completing Form 990-PF

The IRS recommends completing Form 990-PF in the following sequence to limit jumping from one part of the form to another.

<table>
<thead>
<tr>
<th>Seq.</th>
<th>Section</th>
<th>Screens</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IV</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>I and II</td>
<td>52, 53, 54</td>
<td>For required schedules, see “Part I Additional Schedules” and “Part II Additional Schedules” (following).</td>
</tr>
<tr>
<td>3</td>
<td>Heading</td>
<td>1, 51</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>III</td>
<td>SCH3</td>
<td>Select item 5 or 6 from Line Number drop list and enter a description and amount.</td>
</tr>
<tr>
<td>5</td>
<td>VII-A</td>
<td>57</td>
<td>Use screen SC57 to create a schedule for controlled entities.</td>
</tr>
<tr>
<td>6</td>
<td>VIII</td>
<td>OFF</td>
<td>Use the IND screen to enter data for independent contractors.</td>
</tr>
<tr>
<td>7</td>
<td>IX-A through X</td>
<td>59</td>
<td>If an explanation is required for line 1e of Part X, use screen SC59, Reduction Explanation.</td>
</tr>
<tr>
<td>8</td>
<td>XII, lines 1–4</td>
<td>60</td>
<td>Line 4 is calculated automatically in Drake.</td>
</tr>
<tr>
<td>9</td>
<td>V and VI</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>XII, lines 5–6</td>
<td>n/a</td>
<td>Calculated automatically in Drake.</td>
</tr>
<tr>
<td>11</td>
<td>XI</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>XIII</td>
<td>61</td>
<td></td>
</tr>
</tbody>
</table>
Part I
Additional Schedules

Additional schedules may be needed to complete the following lines from Part I (#2 in Table 2):

- Line 6a (Net gain or loss from sale of assets not on line 10) — Use screen SCH5.
- Line 10 (Gross profit or loss) — Use screen SCH7.
- Line 11 (Other income) — Use screen SC50 for subsidiary schedule.
- Line 18 (Taxes) — Use screen SC50 (when required).
- Line 19 (Depreciation) — Use screen DEPR for depreciation schedule. (The lines for Net Investment income and Adjusted net income on the DEPR screen are required for columns B and C of page 1 of Form 990-PF.)
- Line 23 (Other expenses) — Use screen SC50 for subsidiary schedule; use screen DEPR for amortization schedule. (The lines for Net Investment income and Adjusted net income on the DEPR screen are required for columns B and C of page 1 of Form 990-PF).

Part II
Additional Schedules

Additional schedules may be needed to complete the following lines from Part II (#2 in Table 2 on page 7):

- Line 6 (Receivables due from officers, directors...) — Use screen SC14 (when required).
- Line 7 (Other notes/loans receivable) — Use screen SC14 (This produces statement STM 135) and/or screen SCH3 (This produces statement STM 113).
- Lines 10a – 10c (Investments) — Use screen SC54.
- Line 11 (Investments – land, buildings...) — Use screen SC53 for subsidiary schedule (when required).
- Line 13 (Other investments) — Use screen SC53 for subsidiary schedule.
- Line 15 (Other assets) — Use screen SC53 for subsidiary schedule.
- Line 20 (Loans from officers, directors...) — Use screen SC55 (when required).
- Line 21 (Mortgages and other notes payable) — Use screen SC55.
- Line 22 (Other liabilities) — Use screen SC53 for subsidiary schedule.

Using Screen SCH2

Screen SCH2, General Explanation Attachment, allows you to attach explanations for certain parts of the Form 990-PF.

It is necessary to identify which part of the form is to be associated with the attached statement. To select a section of a form, choose an option from the Schedule drop list.
at the top of screen SCH2. Next, write an explanation in the Explanation field. Press PAGE DOWN as needed for additional attachments. Note that there is a 5,000-character limit for e-filing.

The SCH2 screen can be used for other 990 return types. Note that screens O (for Schedule O, Supplemental Information) and SCH2 are the same. See “Schedule O” on page 4 for more information. If X (General explanation attachment) is selected from the Schedule drop list, the attachment will be e-filed with an e-fileable return (990, 990-EZ, or 990-PF).

**Form 990-T**

Form 990-T, Exempt Organization Business Income Tax Return, is used for:

- Reporting unrelated business income and tax liability
- Reporting proxy tax liability
- Claiming a refund paid by either a regulated investment company (RIC) or a real estate investment trust (REIT) on undistributed long-term capital gain
- Requesting a credit for certain federal excise taxes that have been paid
- Claiming Form 8941 credit for small-employer health insurance premiums

Based on the items listed above, an organization may need to complete Form 990-T in addition to its 990, 990-EZ, 990-PF, or 990-N return. See Form 990-T instructions to determine if an organization is required to file Form 990-T.

Form 990-T cannot be e-filed.

**Form 990-T Screens**

All 990-T–specific screens are located under the Form 990T tab (Figure 5).

**NOTE**

Screen 80 must include a selection for item G (organization type) in order for Form 990-T to be produced correctly with the appropriate tax calculated.
Form 990

A tax-exempt organization under section 501(a) must file Form 990 if it has either:

- Gross receipts of $1 million or more
- Total assets of $2.5 million or more at the end of the tax year

For more information on who must file Form 990, see the Form 990 instructions published by the IRS.

Recommended Order for Completing Form 990

The sequence shown in Table 3 is suggested as an efficient method for completing a return for a tax-exempt organization. In general, complete the core form first, and then complete—alphabetically—Schedules A through O and Schedule R, except as specified in Table 3. This order limits the need to jump back and forth from one part of the form to another, as certain later parts are required in order to complete earlier parts.

Table 3: Form 990, Recommended Order

<table>
<thead>
<tr>
<th>Seq.</th>
<th>Section</th>
<th>Screens</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A – F; H(a) – M (heading)</td>
<td>1</td>
<td>This is the “Heading” section of Form 990; line M is completed automatically based on resident state entered.</td>
</tr>
<tr>
<td>2</td>
<td>Schedule R</td>
<td>R, R2, R3</td>
<td>Determine related organizations, disregarded entities, and joint ventures for which reporting will be required. (See Sch. R instructions; Form 990 instructions, Appendix F, Disregarded Entities and Joint Ventures).</td>
</tr>
<tr>
<td>3</td>
<td>Part VII, Section A</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Part VIII, IX, and X</td>
<td>8, 9, and 10</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Header line G</td>
<td>1</td>
<td>Completed automatically in Drake</td>
</tr>
<tr>
<td>6</td>
<td>Parts III, V, VII, and XI</td>
<td>3, 4, 6, IND, 11</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Schedule L</td>
<td>L</td>
<td>Complete if required; see Schedule L instructions.</td>
</tr>
<tr>
<td>8</td>
<td>VI</td>
<td>7</td>
<td>Transactions reported on Schedule L are relevant to determine independence of members of the governing body under Form 990, Part VI, line 1b.</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>2</td>
<td>Complete based on information derived from other parts of the form.</td>
</tr>
<tr>
<td>10</td>
<td>IV</td>
<td>5</td>
<td>Complete this section to determine which schedules must be completed.</td>
</tr>
</tbody>
</table>
Header Information (Forms 990, 990-EZ, 990-PF, 990-T, 990-N)

Use screen 1 to fill out the header section for a tax-exempt organization. Complete all applicable fields. Enter the organization’s ID number, name, address, and telephone number at the top of screen 1.

NOTE

Header information to be completed first are items A through F and H(a) through M. The Gross receipts field (header item G on the 990) is completed automatically.

Foreign Address

If the organization has a foreign address, fill out the applicable fields in the Foreign ONLY section of screen 1.

NOTES

Foreign address fields are locked to keep incorrect address data from being entered. Click the field to unlock foreign address fields throughout the return. Close the return and re-open it to re-engage the lock for unused screens.

To use the foreign address fields, enter in the first field the name of the foreign province or state, as appropriate. Select the appropriate foreign country from the drop list, and then enter the postal code, if appropriate.

Type of Form

To indicate which form the organization is filing, select an option from the Form drop list in the General Information section of screen 1. (See Figure 3 on page 5 and Figure 6 on page 12.) If the only return being prepared is a 990-T and its related forms, mark the 990-T only box.

Form Columns

Screen 1 has separate columns indicating the header boxes for Forms 990, 990-EZ, and 990-PF. For example, the “Exemption application pending” check box on screen 1 (item #1 in Figure 6) puts an “X” in box B of Forms 990 and 990-EZ, or an “X” in box C of Form 990-PF. Note that not all questions are required for all forms (item #2 in Figure 6 on page 12).

---

Table 3: Form 990, Recommended Order

<table>
<thead>
<tr>
<th>Seq.</th>
<th>Section</th>
<th>Screens</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Schedule O and any other applicable schedules</td>
<td>Schedules A – G and Schedules H – R tabs</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>II</td>
<td>PIN; Setup info</td>
<td>See “Part II, Signature Block” on page 21.</td>
</tr>
</tbody>
</table>
**Affiliate Listing (990 Only)**

If the 990 is a group return filed for affiliates, but not all affiliates are included, a list of affiliates must be attached to the return. Screen SCH4 is available for this purpose and includes fields for affiliate name, address, and EIN. Click the SCH4 link on screen 1 (item #3 in Figure 6).

**Note**

The default data for the Name Control field on screen SCH4 is the four-letter code used by the IRS to match the information to the affiliate. This is an override field and must be completed if the name of the affiliate has changed since the entity’s last filed return.

**Tax Year**

The program uses the current calendar tax year (beginning January 1 and ending December 31) by default. If the organization uses a fiscal year, enter the beginning and end dates in the If not calendar year box on screen 1 (Figure 7).

**Schedule R**

Once you have completed the header information on screen 1, the IRS recommends completing Schedule R, Related Organizations and Unrelated Partnership. Schedule R is used to submit data regarding the organization’s relationships with other organizations, both taxable and tax-exempt. The program has three screens for Schedule R, listed in Table 4.

**Table 4: Schedule R Screens**

<table>
<thead>
<tr>
<th>Screen</th>
<th>Sections of Schedule R Covered</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Schedule R, Parts I (Disregarded Entities), II (Related Tax-Exempt Organizations), and III (Related Organizations Taxable as a Partnership)</td>
</tr>
</tbody>
</table>
### Part VII, Section A

Once you have completed Schedule R, the IRS recommends completing Part VII, Section A ("Compensation of Officers, Directors, Trustees, Key Employees, Highest Compensated Employees, and Independent Contractors"). Use the OFF screen to report this information, noting that information entered there is used to generate Part II of Schedule J ("Compensation Information").

**NOTE**

Use the IND screen to enter information about compensation of independent contractors. See "Compensation" on page 16 for more information on the IND screen.

### Parts VIII, IX, and X

Parts VIII, IX, and X of Form 990 comprise the financial statements for tax reporting purposes. These sections are accessed from screens 8, 9A, 9B, 10A, and 10B of the program.

#### Statement of Revenue

The program has two screens for Part VIII, Statement of Revenue. Go to screen 8 to complete items 1 and 3 through 10. Press PAGE DOWN (or click the **Lines 2 11 screen** hyperlink) to access fields for items 2 ("Program Service Revenue") and 11 ("Miscellaneous Revenue").

#### Statement of Functional Expenses

Use the organization’s normal accounting method to complete Part IX, Statement of Functional Expenses. Part IX should not be used to report expenses that belong on lines 6b, 7b, 8b, 9b, or 10b of Part VIII, Statement of Revenue.

### Table 4: Schedule R Screens

<table>
<thead>
<tr>
<th>Screen</th>
<th>Sections of Schedule R Covered</th>
</tr>
</thead>
<tbody>
<tr>
<td>R2</td>
<td>Schedule R, Parts IV (Related Organizations Taxable as a Corporation or Trust), V (Transactions With Related Organizations), and VI (Unrelated Organizations Taxable as a Partnership)</td>
</tr>
<tr>
<td>R3</td>
<td>Schedule R, Part V, Line 1</td>
</tr>
</tbody>
</table>

To enter more entities, press PAGE DOWN to access new, blank fields.

**NOTE**

Schedule R is not required for all organizations. For information on which aspects of Schedule R must be completed by an organization, see the IRS instructions for Schedule R, or click **Screen Help** on screens R, R2, and R3.
Part IX has two screens; to access the first screen (lines 1 through 14), go to screen 9A. To access the second screen (lines 15 through 26), go to screen 9B (or press PAGE DOWN from screen 9A).

Screen Help in the program provides further instructions on this section. To access Screen Help, click the Screen Help button on the upper right corner. (You can also access Screen Help by right-clicking the screen and choosing Screen Help from the right-click menu, or by pressing CTRL+ALT+? from the 9A or 9B screens).

For additional information, see the IRS instructions.

Balance Sheet

All organizations must complete Part X. A substitute balance sheet cannot be used.

Part X has two screens: screen 10A (lines 1 through 15), and 10B (lines 17 through 32). You can access screen 10B from screen 10A by pressing PAGE DOWN.

NOTE

Some end-of-year amounts require separate schedules. Screens for these schedules can be accessed by clicking the applicable links on screens 9A, 9B, 10A, 10B, and 11.

Header Line G

The program calculates line G (gross receipts) of the form header automatically, based on the information entered in on screen 8, (including the linked Line 2 11 Screen).

Parts III, V, VII, and XI

Once you have completed Box G of the header, the IRS recommends completing Parts III, V, VII, and XI of Form 990 (screens 3, 4, 6, IND, and 11).

Purpose & Achievement

Part III, Statement of Program Service Accomplishments, requires that the organization report its new, ongoing, and discontinued exempt purpose achievements, along with any related revenue and expenses.

In Drake, Part III of Form 990 consists of two screens. Use screen 3 to answer items 1 through 3 (exempt purpose). Use screen 4 to complete the line 4 items (exempt purpose achievements). From screen 3, you can access screen 4 by pressing PAGE DOWN.

Exempt Purpose

Use the Primary exempt purpose field on screen 3 to describe the organization’s mission. The mission statement can address why the organization exists, what it hopes to accomplish, whom it intends to serve, and activities it will undertake and where. See IRS instructions for further information on what constitutes a mission.

NOTE

If the organization does not have a mission that has been adopted by its governing body, type None as the Primary exempt purpose.

If you answer Yes to question 2 or 3 on screen 3, use Schedule O (screen O) to describe any new services or changes to services. From screen 3, you can click the Sch O Screen hyperlink to access this screen. See “Schedule O, Supp. Info.” on page 20 for more information about filling out Schedule O in the program.
Exempt Achievement

Enter expenses, revenue, and a description of the exempt purpose achievements on screen 4. Examples of exempt achievements include:

- Providing charity care under a hospital’s charity care policy
- Providing higher education to students under a college’s degree program (the number of students served must be indicated)
- Making grants or providing assistance to individuals who were victims of a natural disaster
- Providing rehabilitation services to residents of a long-term care facility

NOTE

The Program service code drop list on line 4 of screen 4 is not used.

Acceptable exempt achievements do not include any achievement not substantially related to the accomplishment of the organization’s exempt purpose (other than by raising funds).

To enter a description that exceeds the allowed number of characters on screen 4, press PAGE DOWN and continue the description. There is no need to re-enter the information in the top section of the screen. If the description takes up more space than is allowed on the printed return, the program will generate it on a separate SERVICES page. (See Figure 8.)

![Figure 8: Part III of Form 990 references a SERVICES page for descriptions that are too long to be printed on the actual 990 form.]

To enter another achievement, press PAGE DOWN and mark the box labeled Mark this box if starting a new description. The second description entered is shown (or referenced on a SERVICES page, if applicable; see Figure 8) in section 4b of Part III. A third description is printed or referenced in section 4c. Additional descriptions are shown on a SERVICES page generated with the return.

NOTE

The exempt achievement description has a 5,000–character limit for e-filing; if the description exceeds 9,000 characters, the return must be paper-filed.

Other IRS Filings

Part V, Statements Regarding Other IRS Filings and Tax Compliance, is used to show the organization’s compliance with the requirements of other federal tax laws for reporting and substantiation. Use screen 6 in the program to enter data for Part V. In
Drake, Part V consists of two screens: use screen 6 to answer items 1 through 6b; press PAGE DOWN from screen 6 to access items 7 through 14b.

**Compensation**

Part VII reports compensation paid to officers, directors, trustees, key employees, highest-compensated employees, and independent contractors. For Form 990, 990-EZ, or 990-PF, use the OFF screen (for officers, etc.) and the IND screen (for independent contractors) to enter this information.

The OFF screen also has fields for entering an officer address, “books in care of” information, and an indication of whether the specified officer signs the return. The IND screen has fields for name and address, type of service, and compensation, and a field to enter the number of contractors paid more than $100,000 ($50,000 for Form 990-PF) in reportable compensation.

**Reconciliation of Net Assets**

Enter the amount of changes in net assets or fund balances that occurred during the tax year on line 9 line of screen 11. These would include items such as prior-period adjustments and changes in accruals.

**NOTE**

See new instructions provided for lines 5, 6, and 8.

Explain the changes on screen O, selecting code O26 in the Schedule drop list.

**Financial Statements & Reporting**

Part XII, Financial Statements and Reporting, is used for reporting information on the organization’s accounting methods and financial statements. The accounting method (line 1 of Part XII) is pulled from the method indicated on screen 1. Use screen 11 to answer all other items for Part XII.

**Schedule L, Transactions With Interested Persons**

Screen L contains fields for completing Parts I through IV of Schedule L, Transactions With Interested Persons. All or part of Schedule L may be required for certain organizations that file Forms 990 or 990-EZ. Schedule L is used for the following purposes:

- Reporting information on certain financial transactions or arrangements between the organization and disqualified persons under section 4958 or other interested persons
- Determining whether a member of an organization’s governing body is an independent member for purposes of Form 990, Part VI, line 1b (“Enter the number of voting members who are independent”)

For information on which organizations must complete all or part of Schedule L, click Screen Help on the screen L, or consult the IRS instructions.

**Part VI, Governance, Management, and Disclosure**

Part VI, Governance, Management, and Disclosure, requests information regarding the governing body and management governance policies and disclosure practices. Although federal tax law generally does not mandate particular management struc-
tures, operational policies, or administrative practices, every organization is required to answer each question in Part VI.

Use screen 7 to access fields for Section A of Part VI. Press PAGE DOWN to access Sections B and C. If additional information is required for Part VI, use Schedule O (screen O; see “Schedule O, Supp. Info.” on page 20). O Screen links are available on parts of screen 7.

**Part I, Summary**

The summary section of Form 990 is for information regarding the mission, activities, and financial results of the organization. Use screen 2 to complete Form 990 Part I, Summary. (Line 1 of the “Summary” section of Part I flows from screen 3, line 1, Primary exempt purpose.)

**Number of Volunteers**

Enter the number of full-time and part-time volunteers who provided volunteer services to the organization during the reporting year. A reasonable estimate is acceptable if an exact number is not known. If the organization wishes to provide an explanation of how the number was determined, use Schedule O (screen O in the program; see “Schedule O, Supp. Info.” on page 20).

**Line 7b**

If the organization is not required to file Form 990-T, enter a zero (0) for line 7b.

**Lines 8–17**

Prior-year amounts are updated automatically from the previous year’s return. These amounts can be entered or edited on screen 2.

**Part IV, Checklist of Required Schedules**

An organization uses Part IV, Checklist of Required Schedules, to determine which schedules must be completed and filed with the tax return. In Drake, two screens contain fields for Part IV. Open screen 5 to access fields for lines 3 through 24d. Press PAGE DOWN from screen 5 to access fields for lines 25a through 37.

**Schedules**

Use the Schedules A – G and Schedules H – R tabs to access schedules. Click a schedule letter or title to open the screen for that schedule. Specific schedules can also be accessed using hyperlinks within screens. (Figure 9 on page 18)
Figure 9: Screen 5 links to schedules

Some longer schedules require more than one screen to complete. For example, Schedule A consists of screens A, A2, and A3. You can access screens A2 and A3 from the Schedule tab, or you can press PAGE DOWN from screen A to access subsequent screens.

Schedule A

Use Schedule A, Public Charity Status and Public Support, with Form 990 or Form 990-EZ to provide information regarding public charity status and public support.

Use the following screens to enter data for Schedule A:

- Screen A (Part I, Reason for Public Charity Status; required by all organizations filling out Schedule A.)
- Screen A2 (Part I, Line 11, Information about Supported Organizations)
- Screen A3 (Parts II and III, Support Schedules)
- Screen A4 (Part VI, Supporting Organizations)
- Screen A5 (Part V, Type III Non-Functionally Integrated 509(a)(3) Supporting Organizations)

Schedule A is required. At a minimum, amounts must be entered for the current year—even if the amounts are zero. If there are no entries for Schedule A, an EF Message is generated upon calculation, and the return cannot be e-filed.

Field- and screen-level help resources within the program provide valuable supplemental information and tips for completing Schedule A in Drake. Press F1 for field-level help. On screens A and A3, click Screen Help for screen-level help.

Screen A4 consists of two screens. From the first screen, press PAGE DOWN to access Sections B through E on the second screen.

Schedule B, Contributors

Use Schedule B, Schedule of Contributors, with Form 990, Form 990-EZ, or Form 990-PF to provide information on certain contributions reported by the organization. Schedule B is required for contributions from at least one contributor in excess of $5,000. If there are no entries for the required Schedule B fields in the program, an EF
Message is generated and the return cannot be e-filed. In Drake, use screen B to enter Schedule B information.

NOTES

Contributor information on Schedule B is not publicly disclosed. If Schedule B is not required, mark the check box on line IV on the lower left side of screen 1.

Schedule C, Political & Lobbying

Schedule C is required for certain section 501(c) organizations and section 527 organizations filing Form 990 or Form 990-EZ. Use the following screens for Schedule C:

- **Screen C** — Parts I-A, I-B, and I-C
- **Screen C1** — Part I-C, line 5 (names, addresses, and EINs of 527 organizations to which payments were made)
- **Screen C2** — Parts II-A and II-B
- **Screen C3** — Parts III-A and III-B

See the IRS form instructions for who is required to file.

Schedule D, Financial Statements

Filers of Form 990 should use Schedule D to provide the required reporting for the categories listed in Table 5. This table also shows which screens in Drake are available for completing specific information.

Table 5: Schedule D: Items Covered, and Screens Used

<table>
<thead>
<tr>
<th>Category</th>
<th>Section of Schedule D</th>
<th>Screen to Use in Drake</th>
</tr>
</thead>
<tbody>
<tr>
<td>Donor-advised funds (DAFs)</td>
<td>Part I</td>
<td>D</td>
</tr>
<tr>
<td>Conservation easements</td>
<td>Part II</td>
<td>D</td>
</tr>
<tr>
<td>Certain art and museum collections</td>
<td>Part III</td>
<td>D2</td>
</tr>
<tr>
<td>Escrow accounts and custodial arrangements</td>
<td>Part IV</td>
<td>D2</td>
</tr>
<tr>
<td>Endowment funds</td>
<td>Part V</td>
<td>D3</td>
</tr>
<tr>
<td>Investments - Land, Buildings, Equipment</td>
<td>Part VI</td>
<td>D3</td>
</tr>
<tr>
<td>Investments - Land, Buildings, Equipment</td>
<td>Part VI, line 1e (&quot;Other&quot;)</td>
<td>D1E</td>
</tr>
<tr>
<td>Supplemental financial information</td>
<td>Parts VII through X</td>
<td>D4</td>
</tr>
<tr>
<td>Supplemental financial statements</td>
<td>Parts XI through XII</td>
<td>D5</td>
</tr>
</tbody>
</table>

Press PAGE DOWN to go to the next Schedule D screen.

NOTE

Note that Part VI, line 1e ("Other") requires a separate screen from the previous Part VI information. Click the **Line 1e detail** link on screen **D3** or open screen **D1E**.

To enter data for Parts VII through X, go to screen **D4** and select the applicable part from the **Part** drop list (Figure 10 on page 20).
Press **PAGE DOWN** to access a blank **D4** screen and enter data for additional parts.

For information on completing Part XIII of Schedule D, see the “Schedule O, Supp. Info.” section, following.

**Schedule O, Supp. Info.**

The IRS provides Schedule O for filers who must include narrative information for specific lines. Use screen **O** to provide narrative information for Schedule O and for other schedules.

**NOTE**

Screen **O** allows you to enter narrative information for numerous schedules—not just for Schedule O.

To use screen **O**:

1. Open the screen—available through the **Form 990/990EZ** tab, the **Schedule H - R** tab, or—as the **SCH2** screen—from the **Form 990PF** tab. Various other screens feature an **O** screen hyperlink.

2. From the **Schedule** drop list of the **Schedule O** screen, select the schedule and line numbers to be addressed on the screen. In the example on Figure 11, the user has selected **Escrow Account Liability** in order to address Part IV, line 2b of Schedule D.

3. Under **Explanation**, type the narrative information. Note that there is a 9,000-character limit for e-filing.
Press \texttt{PAGE DOWN} to open a blank screen and add supplemental information for another schedule or line.

The codes for the screen are preceded by the letter \texttt{O}.

To add a narrative explanation for an amended return, select \texttt{AMD} (located just before the \texttt{O} items in the drop list). See “Amending a Return” on page 23 for more on amending a return.

To add a general explanation attachment, select \texttt{X} (located at the bottom of the drop list).

Data entered on screen \texttt{O} is printed in the supplemental information section of the specified schedule. For example, the narrative from Figure 11 on page 20 would be printed under Schedule D, Part XIII, “Supplemental Information” on page 4 of the 990.

**Part II, Signature Block**

The signature block on Form 990 contains fields for up to two signatures:

- An officer of the organization
- The paid preparer (if applicable)

If e-filing, enter the paid preparer and organization officer PINs on the \texttt{PIN} screen.

**IMPORTANT**

The applicable ERO or preparer PIN must be entered in \texttt{Setup > Preparer(s)} or \texttt{Setup > Firm(s)} in order to e-file a tax return. For more information on setting up firm, preparer, and ERO information in Drake, see \textit{Drake Software User’s Manual: Tax Year 2014}.

**Note about Preparer ID**

Generally, anyone who is paid to prepare the return must sign the return and fill in the other blanks in the “Paid Preparer’s Use Only” area of the return. An employee of a filing organization is not a paid preparer.

In order to have the preparer ID number (PTIN or SSN) printed in the applicable space on the return, the preparer must:

- Sign the return in the space provided for the preparer’s signature
- Enter the preparer information
- Give a copy of the return to the organization

Any 990 returns (including 990-EZ, 990-PF, 990-N, and 990-T) prepared in Drake Software will have the preparer’s PTIN printed in the “Paid Preparer’s Use Only” section of the return automatically. The only return in which the preparer’s SSN will be printed in the “Paid Preparer’s Use Only” section is one that meets these conditions:

- The \textbf{Section 4947(a)(1)} check box on screen 1 is marked
- Line 12a of Part 5, (screen 6, press \texttt{PAGE DOWN}) is marked “Yes” (for 990 return)
- Line 43 of screen 23 is marked (for 990EZ return)
- Line 15 of screen 57 is marked (for 990PF return)
• There is no PTIN entered for the preparer in Setup > Preparer(s) or no PTIN entered on the PREP screen.

The IRS is not authorized to redact (delete) the paid preparer’s SSN if the SSN is entered in the paid preparer’s block. Form 990 is a publicly disclosable document. Any paid preparer whose ID number must be listed on Form 990 may wish to apply for and obtain a PTIN using Form W-7P.

Filing an Extension

Calendar-year returns are due on May 15, 2015. If an organization uses a fiscal year, the return is due by the fifteenth day of the fifth month after the accounting period ends. By filing Form 8868, an organization can extend the deadline three months (to August 15 for a calendar year return). Form 8868 can be used to apply for an additional three-month extension if the original three-month extension was insufficient.

Use the 8868 screen (available from the Other Forms tab) to apply for an extension. Select the applicable box at the top of the 8868 screen to indicate the type of extension being requested. (See Figure 12)

![Figure 12: Select the type of extension being requested.](image)

If requesting an additional extension, an explanation is required on the 8868 screen.

Form 8868, Application for Additional Extension of Time to File an Exempt Organization return can be e-filed.

Once the extension is e-filed and accepted, to later e-file the return, first, go to the ESUM screen (accessible from the Miscellaneous tab of the Data Entry Menu) and delete the “A” from the ACK Code column.
Amending a Return

Indicate an amended return in the General Information section of screen 1. Note that an explanation is required on screen O for an amended return.

When you amend a return in Drake, the amended information replaces the original in the data file. Before amending a return, you should archive the original to avoid losing previously submitted data. For more information on archiving returns, see “Archive Manager” in Chapter 6 of the Drake Software User’s Manual: Tax Year 2014.

To provide an explanation for an amended return:

1. Open screen O.
2. From the Schedule drop list, select AMD - Amended Return Information. This selection is located between the N and O items in the Schedule drop list, as shown in Figure 13.

3. Enter the explanation in the text box below the drop list. Character limit for e-filing is 9,000 characters.

The amended return should include all information pertaining to the return—not just the new or corrected data.

Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the IRS to change either an entity’s overall accounting method or the accounting treatment of any material item. Form 3115 is eligible for e-file.
Drake customers can fill out and e-file Forms 3115 and related schedules and attachments for 990 returns. This section provides instructions for completing this form and related schedules and attachments in Drake.

In some cases, Form 3115 must still be paper-filed. See “Parts I and III,” starting on page 25, for details.

Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for general automatic change procedures, and to Rev Proc. 2015-14 for a list of automatic changes to which the automatic change procedures in Rev. Proc. 2015-13 apply.

## Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible from the Change in Accounting Method box, located under the Other Forms tab of the Data Entry Menu.

The screens accessible from the Change in Accounting Method section include:

- **Screen 3115 (Change in Accounting Method)** — Used to access fields for Form 3115, including Schedules A through D
- **Screen 311E (Schedule E)** — Used to request a change in depreciation or amortization methods
- **Screen ATT (Explanations and Attachments)** — Used to create and view certain attachments to be generated by the software
- **Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment)** — Used to complete certain parts of Form 3115 that require specific attachments

### Multi-form Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 15 on page 25) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new application you create in Drake. The first should be 1, the second 2, and so on. When using
other screens, such as the 311E or ATT screens, you can use those numbers to indicate which instance of Form 3115 the 311E or ATT screen should be associated with.

**NOTE** If only one Form 3115 is being submitted, you do not need to enter anything in the Multi-form code box.

### Form 3115 Screens

When you open the 3115 screen from the Data Entry Menu, the program displays the first of five 3115 screens. These five screens are:

- **Parts I, III** (Form 3115, Parts I and III)
- **Parts II, IV** (Form 3115, Parts II and IV)
- **A, B, C** (Form 3115, Schedules A, B, and C)
- **D - I, II** (Form 3115, Schedule D, Parts I and II)
- **D - III** (Form 3115, Schedule D, Part III)

As shown in Figure 15 on page 25, you can access these 3115 screens by clicking a link at the top of any other 3115 screen.

**Figure 15:** Tab links on 3115 screen

The next few sections of this document provide instructions for completing the various screens for Form 3115 (including Schedules A through D).

### Parts I and III

Use the **Parts I, III** screen to complete the following sections of Form 3115:

- General Information
- Part I, Information For Automatic Change Request
- Part III, Information For Advance Consent Request

**NOTE** Information should be entered in either the **Part I** section or the **Part III** section, but not both.

**General Information**

Complete all applicable fields in the **General Information** section. Note that the fields for business activity and tax-year change are override fields (Figure 16). Complete these fields only if you want to override the equivalent information entered on screen 1 or screen K.
On the **Type of accounting method change being requested** line, select **Depreciation or amortization**, or **Financial products and/or financial activities**. If requesting another method, describe it in the **Other** text box. (The text box is limited to 20 characters.)

For advance consent requests, state in the **Other** text box the type of method change being requested and a short description of the change (for example, LIFO to FIFO.)

**NOTE**
For automatic change requests, these informational requirements are satisfied by properly completing Part I, lines 1a and 1b of Form 3115. (See “Part I,” following.)

**Part I**
From the drop list on line 1a, choose a **Designated accounting method change number**. If the method is not listed, enter the method on line 1b, in the **Other** text box.

The IRS issued Rev. Proc. 2014-16 to explain how taxpayers can elect to automatically change their accounting methods in order to comply with provisions of the final capitalization regulations. Rev. Proc. 2014-54 further explains how taxpayers can elect to automatically change their accounting methods for the disposition of property in order to conform with the regulations relating to the disposition of capital assets.

**IMPORTANT**
Other resources include Drake’s Knowledge Base article 13402. (For information on using the Drake Knowledge Base, see Chapter 10 of *Drake Software User’s Manual: Tax Year 2014.* )
If any of the scope limitations of section 4.02 of Rev Proc. 2008-52 apply, mark the Yes check box on line 2.

By answering Yes on line 2, you are stating that the Appendix of Rev. Proc. 2002-9 or the procedures in other published guidelines specifically state that the scope limitations are applicable to the required accounting method change.

If you answer Yes on line 2, you must complete all the lines in Part II, Information for All Requests. (Click the Parts II,IV link at the top of the screen to access Part II.) See Form 3115 instructions for more information.

After answering 1a, 1b, and 2 in Part I - Information for Automatic Change Request, click the blue Parts II, IV tab at the top of the screen.

Part II In Part II – Information for All Requests, answer question 3 (see Figure 17 on page 27). If the answer is Yes:

• Ordinarily, the IRS will not consent to a request for a change in method of accounting for the applicant’s final tax year. If the applicant ceases to engage in the trade or business to which the desired change in accounting method relates or terminates its existence in the year of change, the applicant is ordinarily not eligible to make the change under automatic change request procedures unless the applicable section of the Appendix of Rev. Proc. 2011-14 or other applicable published guidance states that section 4.02(5) of Rev. Proc. 2011-14 does not apply to the requested change in method of accounting. If the change is requested under the advance consent procedures, the IRS National Office will consider the reasons for the change in the applicant’s final year (see Part III, line 21) in determining whether to approve the requested change.
• See IRS Form 3115 instructions for details.

Figure 17: Automatic Change Request information

NOTE Not all applicants are eligible to use the automatic change request procedures.
Part III

If this section of the Parts I, III screen is filled out, Form 3115 cannot be e-filed with the return. It must instead be paper-filed before submitting the return. A user fee (a check or money order payable to the IRS) must be included with the paper-filed form.

See Appendix A of Rev. Proc. 2012-1 for more information. For more on applicants who must apply for advance consent, see the IRS Form 3115 instructions.

Taxpayers filing under an automatic change request procedure do not pay a user fee.

If the applicant qualifies for a reduced user fee, enter a check mark on line 23b and go to screen ATT2 to complete the attachment information for Part III, line 23b (located in the bottom half of the screen). Include the necessary information or certification required by Rev. Proc. 2013-1 (or its successor).

Specific statements must also be attached to the return if the applicant answers Yes for line 18 (“Is change request allowed under automatic change?”) or No for line 22 (“All members of consolidated group use proposed method?”). Press F1 in a specific field for more information on attachment requirements. The method for attaching statements in Drake is covered in “Binary Attachments” on page 33.

If requesting multiple automatic accounting method change requests on one Form 3115, go to screen 3115 and in the Part 1–Information for Automatic Change Request section, make a selection from the drop list on line 1a, then use the drop lists below line 1a (see Figure 18) to select account method changes being requested.

Figure 18: Making multiple automatic accounting method change requests

On page 1 of Form 3115, the “Other” check box under “the type of accounting method change being requested” will be marked and a note indicating that multiple automatic change requests (“MULTI AUTO CHNG RQST”) have been made (#1 in Figure 19), and the designated change numbers of the requests appear in the “Description” field of Part 1 (#2 in Figure 19).
Parts II and IV

In addition to the **Multi-form code** text box, the **Parts II, IV** screen consists of the **Part II** and **Part IV** sections, used to complete the following sections of Form 3115:

- Part II, Information For All Requests
- Part IV, Section 481(a) Adjustment

Applicants must complete both sections of this screen. For more information on each line (including instructions for any required attachments), press F1 in a specific field.

Part II, Line 12

Note that there is no field on the **Parts II, IV** screen for Part II, line 12. There is, instead, a link to screen **ATT2**. Fields for line 12, which should be completed if the applicant is changing *only* the accounting method for a particular item or items, are located in the top half of **ATT2** screen. Use these fields to enter information on:

- The items being changed
- The applicant’s present and proposed methods for the items being changed
- The applicant’s present overall method of accounting (cash, accrual, or hybrid)

Note that the bottom half of the **ATT2** screen is for completing Part III, line 23b. Only the top half (for Part II, line 12) must be completed for Part II, line 12.

Schedules A, B, and C

Use the **A, B, C** screen to complete the following sections of Form 3115:

- Schedule A, Change in Overall Method of Accounting (screen covers Part I, Change in Overall Method)
- Schedule B, Change to the Deferral Method for Advance Payments
- Schedule C, Changes Within the LIFO Inventory Method (screen covers both Part I, General LIFO Information, and Part II, Change in Pooling Inventories)

**NOTE**

Schedule A, Part II (Change to the Cash Method for Advance Consent Request) requires attachments and is not addressed on the **A, B, C** screen.
**Schedule A**

This section is required for all applicants filing to change their overall method of accounting. It requires the entry of amounts as they were at the close of the tax year preceding the year of the requested change.

**NOTE**

Leave blank any lines that aren’t required for the entity’s application. Exclude amounts not attributable to the change in method of accounting—for example, amounts that correct a math or posting error, or that correct errors in calculating tax liability.

The IRS requires a worksheet for lines 1a, 1c, 1d, 1e, and 1f of Schedule A. When you enter an amount on any of these lines in Drake, a CTRL+W worksheet is automatically opened, allowing you to begin entering the descriptions and amounts of multiple items for the worksheet. When you close a CTRL+W worksheet, the program returns to the original screen and displays the total in the field. The field is shaded (default is red) to indicate that a CTRL+W worksheet has been used.

**NOTE**

If nothing is entered in a Schedule A field, the program automatically displays the word “NONE” in the field on the generated form.

**Schedule B**

This section has just two lines, both referring to the request for deferral for advance payments:

- **Line 1** — Request change to the deferral method for advance payments (from section 5.02 of Rev. Proc. 2004-34)
- **Line 2** — Request change to the deferral method for advance payments (from section 1.451-5(b)(1)(ii))

See IRS Form 3115 instructions for more information on making these requests.

**Schedule C**

This section has two parts:

- **Part I** (General LIFO Information) — This section is made up of attachment links. If any of the conditions on lines 1–6 match the entity’s situation, click the corresponding attachment link to access the ATT screen, where you can complete the required statement. (Select the corresponding line code from the Schedule drop list on the ATT screen.)
- **Part II** (Change in Pooling Inventories) — Enter the descriptions of the contents and the base years of the present and proposed pools. If any of the conditions on lines 2–4 match the entity’s situation, click the corresponding attachment link to access the ATT screen, where you can complete the required statement.

**Schedule D, Parts I and II**

Use the D - I, II screen to complete the following parts of Form 3115, Schedule D, Change in the Treatment of Long-Term Contracts Under Section 460, Inventories, or Other Section 263A Assets:

- Part I, Change in Reporting Income From Long-Term Contracts
- Part II, Change in Valuing Inventories Including Cost Allocation Changes

**NOTE**

If an entity is currently using a LIFO inventory method or submethod and is changing to another LIFO inventory method or submethod, Part II of Schedule D is not applicable. Use Schedule C, Changes Within the LIFO Inventory Method, instead.

**Schedule D, Part I**

A long-term contract refers to any contract for the manufacture, building, installation, or construction of property that is not completed in the tax year in which it is entered into. Answer the questions in Part I that apply to the entity’s situation.

**Schedule D, Part II**

This section concerns changes in the identification and valuation methods of inventories. Note that some lines require attachments. To access the ATT screen and complete a required statement, click the desired attachment link.

The items on this part of the screen match the items on the actual Form 3115, Schedule D. For information on completing individual lines, see the Form 3115 instructions.

If the entity is unable to furnish a copy of Form 970 (line 5a), the attachment must include the following statement:

**NOTE**

“I certify that to the best of my knowledge and belief (name of applicant) properly elected the LIFO inventory method by filing Form 970 with its return for the tax year(s) ended (insert date(s)) and otherwise complied with the provisions of section 472(d) and Regulations section 1.472-3.”

**Schedule D, Part III**

Use the D - III screen to complete Part III (Method of Cost Allocation) of Form 3115, Schedule D. Part III is required for any entity submitting either Part I or Part II. Screen D - III consists of the following sections:

- Section A, Allocation and Capitalization Methods
- Section B, Direct and Indirect Costs Required to be Allocated
- Section C, Other Costs Not Required to be Allocated

**Section A**

Click the D3-1 Attachment link (see Figure 20 on page 31) to attach a description of the present and proposed methods used to capitalize direct and indirect costs.

**Sections B and C**

Sections B and C consist of a series of drop lists under a Present column and a Proposed column. “Present” refers to the current accounting method, while “proposed” refers to the requested change in accounting methods. You should address only the items necessary; do not make a selection for any item for which an answer is not required for the entity’s situation.
For each item in sections B and C, you can:

- **Select X** — If you select X, the corresponding box on Form 3115 will be marked with an X. (See Figure 21.)
- **Select B** — If you select B, the corresponding box on Form 3115 will be left blank and an attachment will be required explaining why the line was left blank. (EF Messages will outline which statements are missing.
- **Select nothing** — If you select neither of the above options, “N/A” will appear in the corresponding box on Form 3115. No attachment is necessary for a box marked “N/A.”

![Figure 21: X was selected for column 1, lines 1-3; B was selected for column 1, line 4; nothing has yet been selected for any other line.](image)

To attach a statement for section B or C, click the D3-2 Attachment link at the top of Section B (Figure 22 on page 32). A single statement may contain all necessary explanations for sections B and C.

![Figure 22: If any box is marked “B,” click the D3-2 Attachment link to open the ATT screen and complete the fields for an attached statement.](image)

### Safe Harbor Elections

*New for 2014:* A check box was added to screen 4562 to apply a small taxpayer Safe Harbor election to a building listed in the Description field. An election statement will be produced and the building description as entered in the Description field will be included in the election statement.

**NOTE** This Safe Harbor election covers buildings only.

New Options on ELEC Screen

Two other elections are now available from the **Elections** drop list on the **ELEC** screen:

- Sec. 1.263(a) - 1(f) de minimis safe harbor election
- Sec. 1.263(a) - 3(n) Election

Election statements are generated with the return (Figure 23).

**Figure 23:** Election statement generated with ELEC screen selection

The Sec. 1.263(a) - 3(h) election can be made from either the **ELEC** screen or the **4562** screen.

## Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are generally signature or third-party documents such as a copy of a signed lease or a signed appraisal statement. In some instances, the IRS requires that a document be attached to an e-filed return; in other instances, a document can be attached voluntarily to support or explain an entry in the return. In either case, a document must be in PDF format and attached to the return in order to be e-filed with it. Paper documents must be scanned into the computer to be attached.

Attach files through the **PDF Attachments** screen, accessible from the **Electronic Filing** section on the **General** tab of the **Data Entry Menu**.

**NOTES**

This PDF–attachment feature is available in several packages in Drake. Some of the examples shown in this section are from other packages, but the feature works the same way in all packages.

Directions for attaching documents can also be found in the **Screen Help** of the **PDF Attachments** screen, and in item **L** of the **FAQ** screen.

### The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF file to be attached
2. Informing the program that a PDF file will be sent with the return
3. Attaching the PDF file for e-filing

These steps are described in the following sections.

Creating a PDF File

To create a PDF file:

1. Scan the document to be attached to the return.
2. Save the document to your client’s DDM file, your computer’s desktop, or anywhere you can readily find it.

**Tip**

It’s a good idea to use the DDM scanning feature for this step.

Adding PDF Files in Drake

To indicate in the software that a PDF file will be sent with the return:

1. Open the return in Drake. From the **Form 990/990EZ** tab of the **Data Entry Menu**, click **PDF**, or type **PDF** in the selector field and press **ENTER**.
2. Fill out the columns on the **PDF Attachments** screen. See Table 6 for examples.

**Table 6: PDF Attachment Window**

<table>
<thead>
<tr>
<th>Name of Column</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Reference Source | Name or number of regulation, publication, or form instruction that makes attachments necessary | - IRS Pub xxx-1.4  
- Form Instructions for 990 |
| Description | Description of form or document to be attached | - Title of house on Oak Street  
- Appraisal of Lot 1234 |
| File name | Distinctive, easily recognizable file name, followed by “.pdf” | - TitleHouseOakSt.pdf  
- AppraisalLot1234.pdf |

3. Exit the **PDF Attachments** window.

Because you’ve indicated that a PDF file is attached, the program generates an EF Message regarding the attachment when the return is calculated.

Attaching Documents to the Return

To attach a PDF file to a return:

1. From the return, click **View**. If anything was entered in the **PDF Attachments** window (see “Adding PDF Files in Drake,” previously), there will be two PDF-related items in the **View/Print** window:
   - An **EF MESSAGES** alert (item #1 in Figure 24)
   - An **Attach PDF** button on the toolbar (item #2 in Figure 24)
2. Click MESSAGES to view EF messages, including information on how to attach the required documents to the return.

3. Click Attach PDF (item 2 in Figure 24). The EF PDF Attachments window (Figure 25 on page 35) displays the information entered on the PDF Attachments window in data entry. A red X means the document has not been attached; a green check mark indicates an attached document.

4. Click the row of a document to attach.

5. Click Browse.

6. Browse to the proper folder, select the PDF file to attach, and click Open (or double-click the file name).
Repeat for all documents with a red \textbf{X}. When all documents have been attached to a completed return, recalculate the return. If there are no EF messages, the return is ready to be e-filed.

**Printing Generated Documents**

In some instances, Drake generates a document that must be printed, signed, and scanned back into the computer to be attached to the return. An EF message will state that attachments are required. You will then need to obtain and complete the statements, scan them into the computer, save them as a PDF file, and attach them to the return.

**Using the PRNT Screen**

Use the \texttt{PRNT} screen (accessible from the \texttt{Form 990/990EZ} and \texttt{Miscellaneous} tabs) to override most program defaults.

**Suppressing/Forcing Items**

To suppress or force printing of certain items, go the \texttt{PRNT} screen and select the desired options. Selections override the options established in \texttt{Setup}. For more on setting up options globally in Drake, see *Drake Software User’s Manual: Tax Year 2014*.

The following items can be “forced” from the \texttt{PRNT} screen (see Figure 26):

- Diagnostic summary report listing the forms calculated and providing a brief summary of the return
- Next-year depreciation listing for the organization
- Indication on the return that the organization has changed its accounting period
- Preparer’s name in the “Preparer’s signature” line for preparer and client copies of a return that has been e-filed

![Figure 26: PRNT screen options](image)

The following items can be suppressed from the \texttt{PRNT} screen of a 990 return (see Figure 26):

- Commas (in the amounts printed on the forms)
• Columns B, C, and D of Form 990, Part IX, if the organization is not a 501(c)(3) or 501(c)(4) organization (Only Column A, Total expenses, would be generated for this section of Form 990.)
• Data for non-required fields on Form 990-T of gross receipts are $10,000 or less

Overriding Other Setup Options

Filing instructions (federal and state) and envelope coversheets (organization, IRS, and state) can be either forced or suppressed from the PRNT screen to override the global setting in Setup.

NOTE

A default due date for filing is printed on all letters and filing instructions generated with a return. You can override the default date by entering an alternate due date in the Due date to print on letter and filing instructions field on the PRNT screen.

You can also enter the date to be printed on the return. In Setup > Options > Optional Items on Return, you can indicate if the return should have no date or if it should have the current system date. Use the PRNT screen to override the setup option choice for a return.

Turn Off Autobalance

Autobalance forces the balance sheet to balance for both the beginning- and end-of-year amounts by adjusting net assets or fund balance.

The program makes the adjustments due to differences in the balance sheet. Incorrect data entry could cause these differences but they are usually the result of amounts being erroneously deleted or changed from the balance sheet screens. To reconcile the differences, it is best to compare the organization’s beginning and ending balance sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn off autobalance.

Electronic Filing

An organization has the option to e-file Form 990, 990-EZ, 990-PF, 990-N, and related forms, schedules, and attachments. If the organization files at least 250 returns of any type during the calendar year and has total assets of $10 million or more at the end of the tax year, it is required to e-file Form 990.

NOTE

A short period return cannot be filed electronically unless it is an initial return or a final return (one of those boxes is marked on screen 1.) Form 990-T cannot be e-filed.

Steps for e-filing Form 990 are the same as for e-filing Form 1040. For detailed instructions on e-filing returns in Drake, see Drake Software User’s Manual: Tax Year 2014.
To determine if an organization meets the $10 million asset test, use the amount of total assets at the end of the year (Form 990, page 11, line 16).

If an organization is required to e-file but does not do so, it is considered not to have filed its return. See Temporary Regulations section 301.6033-4T for more information.

For additional information on the e-file requirement, visit the IRS website at www.irs.gov. Click the Filing tab, then from the menu on the left, click Charities & Non-Profits, and select e-file for Charities and Non-Profits.

**IRS Error Reject Codes**

If any of the following IRS error reject codes is generated when e-filing a 990 return, the preparer must contact the IRS for further information. The IRS e-Help Desk telephone number is (866) 255-0654

**F990-902-01**: The EIN in the return must have been established as an exempt organization return filer in the e-file database.

**F990-913-01**: Tax-exempt status specified in Item I, must match data in the e-file database.

**F990-913-01**: The “Return Type” indicated in the return header must match the return type established with the IRS for this EIN.

**R0000-922-01**: Filer’s EIN and Name Control in the Return Header must match data in the e-file database, unless “Name Change” or “Name or Address Change” check box is marked, if applicable.
Index

A
accomplishments, statement of 14
accounting method
    changing 23
    multiple changes 28
accounting method used 16
address
    "books in care of" 16
    foreign 11
    of 527 organization 19
    of affiliates 12
    of organization 11
adjustments to balance sheet 37
affiliates 12
amending a return 23
attachments
    from within data entry 8
    general explanation 8
    PDF 33–36
    to Form 3115 24, 31
auto-balance 37

B
balance sheet
    adjustments to 37
    screens 14
blank forms 3
books in care of 16
business income returns (Form 990-T) 9

C
cash (accounting method) 29
Change in Accounting Method 23–32
    multiple changes 28
charity care for hospital 15
checklist of required schedules 17
codes
    multi-form 24
commas, suppressing 36
compensation of officers, etc. 13, 16
contributors (Schedule B) 18
coversheets, options for 37
creating a new return 3
credit for excise taxes 9
Ctrl+W (detail) worksheets 30

date (to print on return) 37
depreciation listing 36
detail (Ctrl+W) worksheets 30
diagnostic summary, printing a 36

e
E-filing
    and PIN signatures 21
    Form 990-N (e-Postcard) 6
    Form 990-T (not e-fileable) 9
    PDF files 33–36
    process 37
Elections
    Safe Harbor 32
e-Postcards (Form 990-N) 5
error reject codes 38
exempt
    achievement 15
    purpose 14
expenses, statement of 13
extension, filing an 22

F
filing
    an extension 22
    instructions (options for) 37
final returns 4
financial statements
    and reporting (Form 990, Part XI) 16
    on Schedule D (Form 990) 19
fiscal year, indicating a 12
foreign addresses 11
Form 3115 (Application for Change in Accounting Method) 23–32
Form 8868, Application for Extension 22
Form 990, Return of Org. Exempt from Income Tax 10–22
Form 990-EZ (short-form return) 6
Form 990-N (e-Postcard) 5
Form 990-PF (private foundations) 6–8
Form 990-T (business income returns) 9
form type, selecting a 11
functional expenses 13
Index

G
governance, management, & disclosure 16
gross receipts 14

H
header information 4, 11
higher education, provision of 15

L
lobbying activities (Schedule C) 19
long-term care services, provision of 15

N
Name Control field (screen 1) 12
name of organization 11
narrative information, providing 20
natural disaster assistance 15
next-year depreciation listing 36

O
officer compensation 13, 16
order for completing
Form 990 10
Form 990-PF 7
organization contact information 11
other IRS filings and tax compliance 15
override
of setup options 37

P
partnerships, unrelated (Schedule R) 12
PDF files, e-filing 33–36
PIN signatures 21
political campaigns (Schedule C) 19
preparer signature 21–22
primary exempt purpose 14
prior-year returns, updating 4
private foundation return (Form 990-PF) 6–8
proxy tax liability 9
public status & support (Schedule A) 18

R
real estate investment trusts (REITs) 9
receipts, gross 14
regulated investment companies (RICs) 9
rehabilitation services 15
reject codes 38
related organizations (Schedule R) 12
required schedules, checklist of 17
returns
creating 3
updating from the prior year 4
revenue, statement of 13

S
Safe Harbor Elections 32
SCH2 (attachment) screen 8
Schedule A (Public Status and Support) 18
Schedule B (Schedule of Contributors) 18
Schedule C (Political Campaign and Lobbying Activities) 19
Schedule D (Financial Statements) 19
Schedule D, Form 3115 30
Schedule L (Transactions with Interested Persons) 16
Schedule O (Supplemental Information) 20
Schedule R (Related Organizations and Unrelated Partnership) 12
schedules, checklist of required 17
SERVICES pages 15
setup options, overriding 37
short-form returns (Form 990-EZ) 6
signature block 21–22
statement
see also financial statements
of functional expenses 13
of program service accomplishments 14
of revenue 13
summary
on Form 990, Part I 17
report printing 36
supplemental information (Schedule O) 20
suppressing commas 36

T
tax
compliance statements (Part V of Form 990) 15
excise, credit for 9
liability, reporting 9
year, specifying a 12
transactions (Schedule L) 16
type of form, selecting 11

U
unrelated business income, reporting 9
updating a prior-year return 4

V
volunteers 17